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Strong Academic Unique Program
Offerings

RepUtaJUOﬂ Wlth Looking for more than a

traditional degree? Dive
World‘ClaSS FaCL,”ty into our interdisciplinary
programs like integrated
science and data science.
You'll tackle complex
challenges, gain hands-on
experience and excel in your
field when you graduate.

Join one of Canada'’s top science faculties, known

for academic excellence and research innovation. At
Western Science, you'll receive the support you need
to excel and graduate with credentials that carry
global recognition.

e Flexible Degree Options

It can take time to discover your academic passion. Our
modular degrees evolve with you, allowing you to tailor your
studies as your interests develop. Whether you're exploring life
sciences, chemistry, mathematics or a blend, Western Science
enables you to create a customized degree that fits your
particular interests and career goals.

Experiential Enriching Social
Learning Opportunities
Take your science learning outside Embrace the full university experience
the classroom by engaging in a range while pursuing your passion for science.
of opportunities to help shape your Join over 180 student clubs, play for a
career path. Enroll in a laboratory- varsity or intramural sports team or
only course, participate in a co-op or showcase your musical talents in our
take a field course led by renowned vibrant music ensembles. At Western,
researchers. Western Science provides you'll build lifelong connections and find
transformational experiences that your community, ensuring a rich and
prepare you for a dynamic career. rewarding student life alongside your
academic journey.
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Your degree will lay the

foundation for a career path tha = B | "
can twist and turn. Developing Y/ = N

the breadth of knowledge and
m

basic fundamentals taught at
Westeri puts you in the driver’s
se avigate these change’

i \

Jeremy Trader, BSc ‘13
Chief Actuary at Knighthead

Annuity & Life Insurance C/1




> Admission

- » Science » Computer Science
OUAC Code: ES OUAC Code: ECS
: Mandatory Mandatory
- » English (ENG4U) » English (ENG4U)
- » Calculus and Vectors (MCV4U) » Calculus and Vectors (MCV4U)
- Plus Two From » Advanced Functions (MHF4U)
» Advanced Functions (MHF4U) Plus One From
» Biology (SBl4U) » Biology (SBl4U)
» Chemistry (SCH4U) » Chemistry (SCH4U)
» Computer Science (ISC4U) » Computer Science (ISC4U)
» Earth and Space Science » Earth and Space Science
(SES4U) (SES4U)
» Mathematics of Data » Mathematics of Data
Management (MDM4U) Management (MDM4U)
» Physics (SPH4U) > Physics (SPHAU)
> Basic Medical )  NOTES:
Sciences
@ First-year biology and
OUAC Code: ESM . :
chemistry courses require
Mandatory Grade 12 Biology (SBI4U) and
» English (ENG4U) Grade 12 Chemistry (SCH4U),
= » Calculus and Vectors (MCV4U) respectively.
» Biology (SBl4U)
» Chemistry (SCH4U) @ For admission into integrated
Recommended science, Grade 12 Chemistry is
b Physics (SPH4U) also mandatory.
1 > Learn more about Admission Requirements
- o
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Offer Accepted! Build Your Base

Once you have accepted As a first-year Science student, you will
your offer, you will have take prerequisite courses along with
access to the services of electives that spark your interests.

Science Academic Advising.

CHOOSE
YOUR OWN
ADVENTURE

v
Thousands of Module Options

At Western, you can customize  can even combine two modules,

your academic journey with or mix a science module with

our flexible module system. one from another faculty (e.g.,

A module is a focused set of Ivey Business School, Arts and

courses within a specific area Humanities or Social Science.)

of study. Most modules beginin  The possibilities are endless! Obk0
year two. Choose from Honours  For more details on each i
Specialization, Specialization, module type, scan the QR code. =i

Major or Minor modules. You

8 WESTERN SCIENCE



Enter Module
You will enter your chosen Stay or Shlft

module in year two and begin
taking more specialized courses.

In year three, you can stay in
your current module or shift your
science discipline.*

Option to enter a 12 to 16-month
paid co-op. @

Unlimited
Prepare to Graduate
In year four, you can complete your _Ca reer

module, often with unique capstone OQtiOﬂS

experiences.
o A degree from

® o Western Science

® will prepare you for
o

0000000000 Years a range of future

Optional . .
pathways, including

industry careers,

You may need additional time graduate school

to finish your degree (e.g., you and professional

complete a co-op or dual- programs such
degree_) as mediCine, |aW,

business and
teacher’s college.

*If you are interested in switching your module, you will need to meet
the new module requirements for graduation. Please consult with
Science Academic Advising.

Sl
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> Computer
Science

Explore a dynamic blend of traditional and cutting-edge disciplines
with Western's Computer Science program. Led by internationally
recognized faculty, dive into the theoretical foundations of computer
science while gaining hands-on experience in high-demand

fields such as game design, cybersecurity, robotics and artificial
intelligence. From software development to advanced studies in
databases and cloud computing, you'll acquire the skills to solve
complex challenges at the forefront of technology. A degree from
Western opens doors to diverse career opportunities in the ever-
evolving world of computer science.

> Modules (*) Popular Courses
» Computer Science » Artificial Intelligence
» Data Science* » Computer Graphics |
» Game Development » Databases
» Software Engineering » Game Programming
*See Data Science program » Human-Computer Interaction
information on page 23 » Introduction to Machine Learning
» Network Security

10 WESTERN SCIENCE
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WHO HIRES '
COMPUTER SCIENCE
GRADUATES?

» Aerospace Industry (e.g., Boeing, Lockheed Martin, Airbus)
» Big Tech (e.g., Google, Facebook, Amazon)

» Telecommunications (e.g., Rogers, Bell, Telus)
» Video Game Developers (e.g., Big Blue Bubble, EA, Digital Extremes) " "




School of
Mathematical

> Mathematics  zistste

Mathematics serves as the universal language that unlocks our
understanding of numbers, shapes and the world around us. At
Western, our Mathematics program goes beyond calculations—it
cultivates computational skills and sharpens your ability to analyze
and interpret complex patterns using this powerful language. From
theoretical insights to practical applications in fields ranging from
economics to biology and information technology, graduates with
expertise in mathematics are in high demand. Prepare for a career
where logical thinking, problem-solving and data analysis are key, and
where your skills will make a significant impact.

Modules
» Applied Mathematics
» Mathematics
» Mathematical and Statistical Sciences

(*) Popular Courses
» Differential Equations
» Computer Algebra
» Topology
» Game Theory
» Cryptography
» Mathematical Biology

12 WESTERN SCIENCE
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~ L .o .
The Faculty of .
ducation at
‘m[;;;ftg“ e L
offers adirect =
hathway to the .
Teacher Education
dDrogram for
qualified candidates
from Western’s
.iﬁimmﬁ)
actuarial science,
financial modelling,
data science,
and statistics

programs.

..\.

LE

M A ) ;_; -l':.'-;
GRADUAT

» Banking and Finance (e.g., F
» Big Tech (e.g., Google, Facebt
» Government

» Insurance (e.g., Canada Life, Intact, Sun Life, Desjardins)



> Statistical

Sciences

School of
Mathematical

and Actuarial @i

How do you make the best decision when given data? Statistics is the
science of extracting meaningful information from data and evaluating
the level of uncertainty in a given conclusion. From designing
experiments to evaluate the effectiveness of a new drug to predicting
stock market prices and modelling life insurance and pension plans,
the teaching and research carried out by the Statistical and Actuarial
Sciences program have many real-world applications. All modules
combine application, technical skills and theory to prepare graduates
for careers in a diverse range of sectors.

> Modules

» Actuarial Science

» Applied Financial Modelling
» Applied Statistics

» Data Science*

» Financial Modelling

» Statistics

*See Data Science program information
on page 28

(*) Popular Courses
» Actuarial Mathematics
» Business Skills
» Corporate Finance
» Financial Modelling
» Generalized Linear Models
» Mathematics of Finance
» Statistical Programming

14 WESTERN SCIENCE
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ance .g.. Royal Bank of Canada; TD Canada Trust, Manulife)

A
aoogle, Facebook, Amazon) \

g.g., Canada Life, Intact, Sun Life, Desjardins)




g

- WHO HIRES
HEMISTRY °
RADUATES?

dd Production Companies (e.g., Parmalat, McCormic
Enforcement Forensic Labs (e.g., Ontario Provinci
aterials Manufacturing (e.g., 3M, BASF, DuPont) =
Pharmaceutical Industry (e.g., Sanofi Pasteur, Amgen, Apotex)

abatt Breweries)
Police, RCMP)
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>»Chemistry

Known as the central science, chemistry explores the interactions
of atoms, molecules and materials, forming the foundation of
disciplines ranging from engineering to medicine. Western's
Chemistry program provides hands-on learning essential for
mastering this interdisciplinary field. With over 600 hours spent
in state-of-the-art labs, students gain proficiency in cutting-edge
tools and techniques of organic, physical and computational
chemistry. This immersive approach not only prepares graduates
for advanced studies and research but also opens doors to diverse
career opportunities in industries where chemistry plays a crucial
role—such as pharmaceuticals, manufacturing and alternative
energy generation.

> Modules

» Biochemistry and Chemistry
» Chemistry

(+) Popular Courses
» Medicinal Chemistry
» Modern Chemical Synthesis
» Polymer Chemistry
» Molecular Structure and Simulation
» Radiation, Nuclear and Radiopharmaceutical Chemistry
» Transition Metals and Catalysis
» Chemical Research, Discovery and Scientific Communication

WESTERN SCIENCE 17
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> WHO HIRES PHYSICS
AND ASTRONOMY
GRADUATES?

» Space Industries (e.g., Canadian Space Agency, MDA, Boeing, Airbus)

» Big Tech (e.g., Google, Facebook, Amazon)

» Hospitals and Medical Research and Development (e.g., Toronto General
Hospital, Charles River Laboratories, Syneos Health)

» Manufacturing (e.g., General Dynamics, Diamond Aircraft)

[Re




> Physics and
Astronomy

From the smallest scales of the atom to the vast expanses of the
cosmos, the Physics and Astronomy program explores how matter,
forces and energy shape our world. Our interdisciplinary research
spans from developing cutting-edge medical imaging techniques
to analyzing data from space telescopes like the James Webb. As
an undergraduate, you'll play a pivotal role in groundbreaking
discoveries, honing your problem-solving and critical thinking skills.
Graduates embark on diverse careers—from advancing medical
imaging to tackling environmental challenges like climate change—
pioneering both in basic science and applied fields.

> Modules (+) Popular Courses

» Advanced Physics » Astrophysics of

» Astrophysics Interstellar Space

» Medical Physics » Quantum Mechanics

» Physics » Radiological Physics

» Scientific Computing > Se_arch for Life in the

and Numerical Methods Universe

» Quantum Computation
» Space Flight Experiments
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> Biology

Dive deep into the complexities of life itself with Western’s Biology
program. Our research programs explore a wide range of topics, from
single genes and organism development to the responses of plants
and animals to climate change, population dynamics and the ecology
of insects, birds and fish. The program covers the breadth of modern
biology. With a focus on innovative teaching strategies, our 78 diverse
courses offer hands-on learning experiences, including immersive
field studies and impactful capstone thesis projects. At Western, the
undergraduate biology experience prepares you for a wide range of
career opportunities, equipping you with the knowledge and skills to
make a meaningful impact across industries.

Modules (*) Popular Courses
» Animal Behaviour » Animal Diversity: Ancestral
» Biodiversity and Conservation Vertebrates to Jellyfish
» Biology » DNA: Genome Organization,

M i R :
» Ecosystem Health utagenesis and Repair

. » Evolution of Plants
» Genetics

» Global Change Biology

» Genetics and Biochemistry
» Physiology of Animal Migration

» Synthetic Biolo
Y &Yy » Principles of Human Genetics

20 WESTERN SCIENCE
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>Basic Medical
Sciences

The Bachelor of Medical Sciences (BMSc) program is a collaboration
between the Faculty of Science and the Schulich School of Medicine
& Dentistry. This program merges scientific principles with practical
applications in the diagnosis, prevention and treatment of human
diseases. In your first two years, you'll build a strong foundation in
biology, chemistry, physics and mathematics with the Faculty of
Science. As you progress to your third year, you'll transition into

the BMSc program, where you'll explore the complexities of human
health and disease through specialized courses offered by our
Faculty of Medicine and Dentistry. Whether you choose to keep your
studies broad with an interdisciplinary focus or specialize in areas
like biochemistry or epidemiology, the BMSc program prepares you
for medical or dental school, graduate training or a variety of health
care careers.

> Modules (*) Popular Courses

» Biochemistry » Cadaveric Anatomy

» Epidemiology and Biostatistics » Human Pharmacology and

» Interdisciplinary Medical Therapeutic Principles
Sciences » Medical Imaging

» Medical Bioinformatics » Microbiology and

» Medical Biophysics Immunology

» Medical Cell Biology » Neurobiology of Mental

) ) lliness

» Microbiology and Immunology
N ) BSc d » Translation in Cancer

» Neuroscience (BSc degree) Biology

» One Health

» Pathology

» Physiology and Pharmacology

22 WESTERN SCIENCE




Many
graduates
.of the basic
medical
sciences
program go
on to pursue
professional
programs

‘ such as

F - medicine,
dentistry,
nursing and
optometry.

WHO HIRE i *
MEDICA "!‘M @ |
GRADUA ey

» Biotechnology Companies (e.g., Nova r‘ ordisk,
ThermolFisher Scientific, Moderna)

» Health Care, Health Services or Public Health
(e.g., Public Health Agency of Canada)

» Medical Research and Development (e.g., Charles River
Laboratories, ICON, Syneos Health)

» Pharmaceutical Industry (e.g., Sanofi Pasteur,

Amgen, Apotex)
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)
Pursuing n oduleiin
geology, geophysics
or environmental
geoscience will
help you meet
professional
registration
qualifications to
become a licensec
geoscientist after
graduation/

WHO HIR
AND NVIRO

SCIE

> Conservatlo e.g.,
Communities Car _
» Energy Sec ] (eé' Shel eV

» Government (e

of Natvo -
e‘ ange Ca
» Mining and Exploration (e.g., Teck Resource |rkIand Lake Gold)
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> Earth and
Environmental
Science

Delve into the dynamic processes that shape our planet and
examine how human activity influences vital resources such as
critical minerals, energy sources, clean water and arable land.
Western's Earth and Environmental Science programs offer a
comprehensive understanding of the physical, chemical and
biological forces driving Earth’s evolution and the environmental
challenges we face today—including climate change, biodiversity
loss and pollution. As an undergraduate student, you can study
anything from foundational geology and geophysics to cutting-edge
sustainability practices. Domestic and international field courses
provide immersive, hands-on learning experiences that bring
classroom concepts to life.

> Modules (*) Popular Courses

» Environmental Science » Catastrophic Events in
» Geology Earth History

» Geology and Biology » Earth Rocks!
» Geophysics » Environmental Science

» Planetary Science and Space and Sustainability
Exploration » Geomicrobiology

» Life on Planet Earth
» Geochemistry
» Physics of the Earth
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> Integrated e
Science

Tackling today’s biggest challenges—like climate change, renewable
energy and antibiotic resistance—requires a multidisciplinary
approach. Western's Integrated Science (WISc) program combines in-
depth coursework with a dynamic blend of integrated science courses,
emphasizing the interconnected nature of science. This program

not only provides specialized knowledge but also fosters a broad
perspective, essential for collaborating with experts across various
fields. With small class sizes and a focus on teamwork, WISc hones
your critical thinking, problem-solving and leadership skills while
covering a wide range of scientific disciplines. Prepare to innovate and
lead in a complex world with WISc.

Integrated (*) Popular Courses
Science Modules » What Scientists Do
» Astrophysics » Exploring Science
» Biology » Sustainability and the Environment
» Chemistry » Discovering Research
» Earth Sciences » Science in Your Community
» Environmental Science » Peer Mentoring and Leadership
» Genetics » Integrated Research Project
» Mathematical & Statistical
Sciences
» Physics
» Synthetic Biology

26 WESTERN SCIENCE




6

5
i

WHO HIRES | Admission
I NTEG RATE D Visit the Ontario Universitié‘?’ —
SCI E N C E Application Centre and apply to

Science (code ES). Choose Western
G RAD UATES? Integrated Science (WISc) as your
“Subject of Major Interest” and
complete the WISc supplemental
application. In addition to the
general Science requirements, you
need Grade 12 Chemistry (SCH4U

or equivalent).

» Integrated Science graduates are employable
in a wide range of industries and professions.
The Integrated Science module in which you
choose to specialize will best determine your
potential career trajectory. Many Integrated
Science students also continue to pursue
graduate and professional programs, such as
medicine and law.




WHO HIRES
DATA SCIENCE
GRADUATES?

» Banking and Finance (e.g., Royal Bank of Canada, TD, Manulife)

» Big Tech (e.g., Google, Facebook, Amazon)

» Insurance Companies (e.g., Canada Life, Intact, Sun Life, Desjardins)
» Telecommunications (e.g., Rogers, Bell, Telus)




An Interdisciplinary

> Program Offered Jointly
a a by the Department of

Computer Science and the

S C I e n C e Department of Statistical
and Actuarial Sciences

In our data-driven world, understanding and interpreting vast
amounts of information is more important than ever. Western's
Data Science program prepares you to navigate this complexity by
teaching you a wide range of tools and techniques for collecting,
analyzing and modelling data. This program merges computer
science with statistical science, providing you with a comprehensive
skill set that spans both disciplines. As a student, you'll gain hands-
on experience with real-world data and learn how to uncover valuable
insights. Data science is a dynamic and growing field, with data
scientists being highly sought after in today’s job market. At
Western, you'll be well-equipped to excel in this impactful and
evolving profession.

> Popular Courses

» Artificial Intelligence

» Data Structures and Algorithms

» Discrete Structures for Computing

» Introduction to Machine Learning

» Software Project Management

» Software Tools and Systems Programming

WESTERN SCIENCE 29







Experience the vibrant life of Western Science

outside the classroom.

Science Students’ Council

Step into a leadership role with )

the Science Students’ Council! =) E-];
Join a passionate team of 64 ]
students advocating for your

peers and shaping the future of the Faculty
of Science. It's a fantastic chance to develop
leadership skills, connect with fellow science
enthusiasts and make a real impact on
campuis life.

Science Clubs

Enhance your university experience and
expand your network with one of our 21
science clubs. Find academic support, join
exciting events, connect with professors
and make lasting friendships. Plus, you can
take on an executive role to build valuable
leadership skills.

Residence Living Learning Floors

Launch into Western!

Don’'t wait until oEA0
September to get : =
to know Western! [w]

Our Western Launch

program offers an immersive
summer experience, where

you can spend the day or stay
overnight on campus. Explore
Western's community and get
an early start on your university
journey.

Mentorship Program

Transitioning to university is a
breeze with our Launch Peer
Mentorship Program. Connect
with upper-year mentors from your
faculty who will guide you through
academic challenges and social
experiences, helping you feel right
at home from day one.

Imagine living in a residence where your floor is filled with fellow science students!
Western's themed living floors—Medway-Sydenham Hall for science, Perth Hall

for computer science, Ontario Hall for integrated science and Elgin Hall for medical
sciences—offer a unique opportunity to form study groups, gain insights from upper-

year mentors and build lasting friendships.

WESTERN SCIENCE 31




Your journey at Western is supported every
step of the way. Our dedicated team is here to
guide you!

Academic Advising

Starting university is a big step, and the Science & Basic Medical Sciences
Academic Advising team is here to guide you through it. Whether you need help
mapping out your academic path, managing coursework or ensuring you stay
on track for graduation, our team is dedicated to your success.

Department Advising

For tailored advice on your specific module, our Department Advisors
are your go-to experts. With in-depth knowledge of their departments,
they'll assist you with course selection and help you navigate your
academic journey with confidence.

The Math-Physics Accelerator

Struggle with math or physics? No worries! The Math-Physics Accelerator
provides free, one-on-one support from graduate student Teaching
Assistants. Get the help you need to excel in these crucial subjects.

Learning Development & Success

Balancing university demands can be tough. The Learning Development &
Success team is here to help you build essential skills, manage stress and thrive
academically. Discover your strengths and find effective strategies to succeed.

Scholarships

We believe in supporting your achievements. Explore numerous scholarships
and awards designed to help you excel, including the RBC Scholarship in Data
Science and the WSIB Scholarships aimed at supporting students in Statistical
and Actuarial Sciences, Computer Science and Data Analytics.

32 WESTERN SCIENCE
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Science Co-op Program

Gain hands-on, career-focused experience through the Science Co-op Ok=10
Program. You'll work with an organization on projects that make a real F <
impact. Work terms range from 4 to 16 months and can begin as early as (=]

the summer after your second year, with most students completing 12 to
16 months of co-op following their third year. By the end of your co-op, you'll not only
have practical experience under your belt but also a strengthened resume that sets

you apart in the competitive job market.

Career Support

Be ready to enter the workforce after
graduation with career planning assistance
from the Science Careers and Professional
Experience team. In addition to helping
you answer career-related questions,

our team will provide access to job fairs
and information sessions, networking
opportunities, as well as resume and
interview preparation.

Experiential Learning

Round out your lectures with real-

world experience. There are countless
opportunities over the course of your
undergraduate experience for high-impact
learning opportunities.

» Summer Research: Explore your
interests and develop technical skills
by working in a lab for the summer,
mentored by world-class researchers
and their graduate students

Capstone Projects: Finish your
final year with your own research
project to explore an area of
interest

Lab Courses: Use
experimentation to bring lecture
material to life in one of many lab
courses offered

Field Courses: Travel, explore
and do research locally or
internationally while getting credit
for it

International Learning
Opportunities: Go abroad to
further your skills with exchanges
and study abroad programs,
summer research, internships or
volunteer opportunities

Community Engaged Learning:
Collaborate with a community
partner to use your learnings to
improve their business operations
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Each of Western’s life science programs
has a unique focus, but they all are
designed to prepare you for graduate
studies or professional paths in fields like
medicine, dentistry, education and therapy.

Biology
Faculty of Science

Are you fascinated by how life works?
The Bachelor of Science (BSc) program
lets you explore life in all its forms, from
entire ecosystems down to the tiniest
genes. You'll learn how plants, animals
and microorganisms interact with each

Medical Sciences

Faculty of Science and
Schulich School of Medicine
& Dentistry

If you're interested in understanding
how the human body works and how
it fights diseases, the Bachelor of
Medical Sciences (BMSc) is for you.

This program dives into the molecular,
cellular and systemic levels of the
body by focusing on how the body
adapts to challenges like illness and
environmental changes.

other and their environments, making this
program perfect if you're curious about
nature and living organisms.

Health Sciences
Faculty of Health Sciences

Want to study how health and wellness are managed in today’s world? The Bachelor of
Health Sciences (BHSc) program covers a wide range of topics from health promotion
to aging, rehabilitation and even global health systems. It's the ideal program if you're
interested in improving health outcomes and exploring how society deals with health
challenges both locally and globally.

WESTERN SCIENCE 37




Discover the
community and s i

SO T e o = ——
Western Science_ .
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